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1. Lwu y quan trong

S6 tay st dung dién tl nay danh cho moi
nguwi dung str dung man hinh Philips.
Hay danh thoi gian doc sb tay st dung
nay truéc khi st dung man hinh. Sé tay
bao gébm nhirng théng tin va cac lvu y
quan trong lién quan dén viéc s dung
man hinh.

Ché dd bao hanh cta Philips ap dung voi
diéu kién la san phadm phai dwoc st dung
dung cach theo muc dich str dung, theo
cac hwdng dan hoat ddng clng vai viéc
xuét trinh héa don gbc hoéac bién nhan
tién mat ghi rd ngay mua, tén ngudi ban,
mAau ma va ma sb san xuét ctia s&n pham.

1.1 Lwu y an toan va bao dwéng

?) canh bao

S dung cac nut diéu khién, diéu chinh
hoac cac quy trinh khac ngoai cac quy
trinh dwoc néu rd trong tai liéu nay cé thé
khién nguoi dung dé bi dién giat, gap cac
rGi ro vé dién va/hodc co hoc.

Hay doc va thwe hién theo cac huwéng dan
sau khi két ndi va str dung man hinh may
tinh:

Hoat dong

« Hay dat man hinh & khu vyc khong cé
anh sang truc tiép ctia mat, anh sang
riec co cwong dé manh va cach xa
bat ky ngudn nhiét nao khac. Bat man
hinh lau ngay trong méi trwedng nay cé
thé khién cho man hinh bj bac mau va
hong.

« Di chuyén moi dé vat c6 thé roi vao
cac 16 thdng gid cia man hinh hodc
ngan can qua trinh lam mat thich hop
cla cac thiét bj dién tlr bén trong man
hinh.

« Khong bit kin cac 16 thdng gi6 trén vd
man hinh.

« Pam bado d&t man hinh & gan noi cé
phich cdm va 6 cédm dién.

« Néu tat man hinh bang cach rut cap
ngudn hodc day dién DC, hay doi 6
giay trwde khi cdm cap ngudn hoac
day dién DC dé man hinh hoat déng
binh thwdng.

« Hay ludn dung cap nguén chuan duoc
cap bdi Philips. Néu thiéu cap nguén,
hay lién hé v&i trung tdm dich vu tai
dia phwong ban. (Vui long tham khao
muc Trung tdm thong tin tiéu dung
cham so6c khach hang)

« Khoéng dat man hinh & noi bj chan
déng hay va cham manh khi dang
hoat déng.

« Khoéng dap hoac lam roi man hinh khi
dang hoat déng hod&c khi di chuyén.

Bao dwdng

« P& man hinh khoéng bj héng, khéng dé
nén qua manh |lén mat man hinh LCD.
Khi di chuyén man hinh, hay ndm chat
khung man hinh dé& nhéc 1én; khéng
nhAc man hinh bang cach dat ban tay
hoac ngoén tay Ién mat man hinh LCD.

« Rt phich cdm man hinh néu ban khéng
dinh st dung né trong thoi gian dai.

« Rt phich cdm man hinh néu ban céan
lau chui man hinh bang mét miéng
vai hoi wét. Ban co thé lau man hinh
bang vai kho khi da ngat dién. Tuy
nhién, drng bao gi® dung dung mai
hiru co, chéng han nhw cdn hodc cac
chét 1dng cé ngudn gbc tlr amoniac dé
lau man hinh.

« Pé tranh nguy co bj dién giat hoac
héng vinh vién bd man hinh, khdng
dat man hinh & noi c6 bui, mwa, nwéc
hodc & noi qua am wét.

«  Néu man hinh bi wét, hay lau né bang
vai khd cang sém cang tét.

« Néu chét la hoac nwéc dinh vao man
hinh, hay ngéat dién ngay va rat cap
ngudn. Sau d6 lau sach chét la hodc
nwéc réi givi man hinh dén trung tam
bao dwdng.



Khéng cat gilr hodc st dung man hinh
@ noi c6 nguon nhiét, anh nang tryc
tiép hodc qua lanh.

Dé duy tri hoat ddng tdi wu ciia man
hinh va s dung né trong th&i gian dai,
hay dung man hinh & noi ndm trong
gi¢i han nhiét dé va dé am sau.

« Nhiét do6: 0-40°C 32-95°F

- D6 am: 20-80% RH

Théng tin quan trong vé Thir néng/Anh
béng ma.

Ludn bat trinh bao vé man hinh
chuyén déng khi ban khéng st dung
man hinh. Ludn bat irng dung lam maoi
man hinh dinh ky, néu khéng, man
hinh clia ban sé hién thj nhirng noi
dung tinh khéng thay déi. Hién thi lién
tuc cac anh tinh trong mét thoi gian
dai co thé gay ra hién twong “anh thor
néng”, con dwoc goi la “anh ao” hay
“anh béng ma”, trén man hinh cua
ban.

“Anh thr ndng”, “Anh &o” hay “Anh
bong ma” la hién twong phd bién trong
céng nghé man hinh LCD. Trong hau
hét cac trwdng hop, hién twong “anh
thtr ndng” hoac “anh ao” hay “anh
bong ma” sé& dan dan bién mét sau
mot thdi gian man hinh bi ngét dién.

@ Canh bao

Khéng thé bat anh bao vé man hinh, hoac

tng dung cap nhat man hinh dinh ky c6

thé gay ra cac sw cb “thtr néng” hodc “anh

sau” hodc “anh boéng ma” nghiém trong
von sé€ khong bién mat va cling khong
thé khac phuc. Thiét hai vira néu khéng

bao gdm trong chinh sach bdo hanh cua

chung toi.

Dich vu

« Chi nhan vién dich vu chuyén mén
m&i dwoc mé vo boc man hinh.

« Néu can moi tai liéu hwéng dan dé
stra chira hoac tich hgp man hinh,
hay lién hé v&i trung tdm dich vu tai

dia phwong ban. (vui long tham khao
chuwong “Trung tdm théng tin tiéu
dung”)

Dé biét thong tin vé viéc van chuyén,
vui long tham khao muc “Théng so ky
thuat”.

Khéng dat man hinh trong xe hoilcdp
xe duwéi anh nang truwc tiép.

& Ghicha

Hay tham khao y kién cua ky thuat vién
dich vu néu man hinh khéng hoat ddng
binh thwdng hodc néu ban khéng chac
phai thwc hién quy trinh nao khi da lam
theo cac hwéng dan hoat ddng néu trong
sb tay nay.



1.2 Mb ta biéu twong

Cac muc phu sau day mo ta cac quy wéc
vé biéu twong dung trong tai liéu nay.

Ghi chu, Lwu y va Canh bao

Trong toan bo sb tay nay, cac doan chiy
c6 thé di kém biéu twong va dwoc in dam
ho&c in nghiéng. Cac doan nay bao goém
cac ghi cha, lwvu y hoac canh bao. Chung
dwoc st dung nhu sau:

& Ghichu

Biéu twong nay cho biét cac théng tin
quan trong va cac bi quyét giup ban tan
dung tét hé théng may tinh.

O Luu y

Biéu twong nay cho biét cac thong tin gitp
ban biét cach tranh dwoc sy cb hdng héc
tiém an dbi véi phan cirng hodc méat div
liéu.

) canh bao

Biéu twong nay cho biét sy tdn thuwong
co thé tiém 4n va gitp ban biét cach tranh
dwoc sy cd do.

Mét s6 canh bao cé thé xuét hién & nhiéu
dinh dang va cé thé khéng di kém moét
biéu twong. Trong nhirng trwdng hop nay,
cach thirc trinh bay cu thé cla canh bao
do dwgc quy dinh b&i co quan chirc nang
lién quan.

1.3 Vvt bé san pham va vat liéu
doéng goi

Thiét bj dién & dién t& bj virt b6-WEEE

This marking on the product or on its
packaging illustrates that, under European
Directive 2002/96/EC governing used electrical
and electronic appliances, this product may

not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations
on how to dispose of your old monitor and
packing from your sales representative.



Taking back/Recycling Information for
Customers

Philips establishes technically and economically
viable objectives to optimize the environmental
performance of the organization's product,
service and activities.

From the planning, design and production
stages, Philips emphasizes the important of
making products that can easily be recycled. At
Philips, end-of-life management primarily entails
participation innational take-back initiatives

and recycling programs whenever possible,
preferably in cooperation with competitors,
which recycle all materials (products and
related packaging material) in accordance with
all Environmental Laws and taking back program
with the contractor company.

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit

http://www.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/
productrecyclingservices.page



2. Cai diat man hinh B Lépchanaé ‘
1. Dé‘lt man hinh nam sap trén bé mét‘
mém min, cin than dé tranh lam tray

2.1 Lap dat xwac hodac hdng man hinh.
2. Gan try dé gi® vao man hinh cho dén
E} Noi dung g6i hang khi n6 khoa vao thich hop.
Start

3. Gilr chan dé man hinh bang ca hai tay
va lap chat chan dé vao tru de.

| PHILIPS

(3

VGA (tuy chon) DVI (tL‘Jy_chon)



El Két ndi véi PC

PHILIPS

© Dau vao ngudn dién AC
© Dbiu vao VGA
© Dau vao DVI-D (cé sdn cho cac mau

vira chon)

@ Dau vao am thanh (c6 sén cho cac

mau vira chon)

© Khoa chéng trom Kensington

Két ndi voi PC

1.

Cam chat cap nguén vao mét sau cla
man hinh.

Tat may tinh va rat cap ngudn.

Cam cap tin hiéu man hinh vao 16 cadm
video & mat sau may tinh.

Cam cap ngudn cla may tinh va cap
nguén ctia man hinh vao 6 cdm dién
gan do.

Bat may tinh va man hinh. Néu man
hinh hién thi hinh anh thi qua trinh cai
dat da hoan tat.

2.2 Str dung man hinh

El Mb ta mit trwdc cia san pham

4 )

PHILIPS

\ = cccoo
Mau 226V4LA

(5]
AUTO/ W 1 /A 0-/4 /0K 0)
© o 06 o o
Mau 226V4L

(5
AUTO/VY  [0/A 0/« /0K 0)

| R |
(7 6 © 6 o (1

BAT va TAT ngudn man
I .
o O hinh.
Truy nhap menu OSD.
O &) /0OK|Xéac nhan diéu chinh menu
OSD.
© 4d |Tré vé mirc OSD trude.
O O [Chinhddsang.
© | A ¥V Chinh menu OSD.
1l | Chinh am lwgng loa.
e > >
) |Bai dinh dang hién thi.
©@ AUTO |Tw ddng chinh man hinh.




. Cai dat man hinh
Bl M6 ta menu Hién thi trén man hinh Menu OSD

Hién thj trén man hinh (OSD) la gi? Duéi day Ia tong quan ve co cau cla
Hién thi trén man hinh (OSD) I3 mét tinh men Hien thi trén man htlr?“h' B?” o the
nang cé & moi man hinh LCD cda Philips. St dung cocau nay iam thong fin tham
N6 cho phép nguoi diing didu chinh hoat khgo khi ml‘Jon thuwe hién cac diéu chinh
dong ctia man hinh hodc chon cac chirc khac sau nay.

nang cdia man hinh triec tiép thong qua

. N 2 i x Y N \ Main menu Sub menu
mot cira sO hwdng dan hién thi trén man
hinh. Mot giao dién hién thi trén man hinh
dé st dung dwoc thé hién nhu sau: VGA
— Input I:
M&u 226VA4LA: , -
(available for selective models)
— Picture Format — Wide Screen, 4:3
— Picture
— Brightness — 0~100
— Contrast — 0~100
L— SmartContrast —— On, Off
Color
S— 0 —— Stand-Alone — On, Off
anguage — — Audio
— Mute — On, Off

(available for selective models)

Color Temperature — 6500K, 9300K
| — Color
! . : sRGB
3 e 5 User Define Red: 0~100
@ Color - - Green: 0~100
5 ' Blue: 0~100
3 Language e
= — Language — English , Espafiol, Frangais, Deutsch, Italiano,
L 0SD Settingg n .
Portugués, Pyccknin, AR, Turkge
v
= = ) — Horizontal — 0~100
Mau 226V4L (cho mau 1A): — OSD Settings
— Vertical — 0~100
. Picture Format ¢ Wide Screen
Picture m — Transparency — Off, 1, 2, 3, 4
Contrast N A A]] 50 L — OSD Time Out —— Bs, 10s, 20s, 30s, 60s
SmartContrast - Off
Language L Setup — Auto
0SD Settings - — H. Position — 0~100
Setup — V. Position — 0~100
— Phase — 0~100
, = > ‘ . A s — Clock — 0~100
Hwéng dan co ban va don gian ve cac
nl]t dl‘éu khlén — Resolution Notification — On, Off
. > 4 A . LR _
Trong menu OSD minh hoa & trén, ban co eset Yes, No
2 X 7 ’ > \ - , > .
thé nhan ¥ A cac nut @ go mat trwdc cua — Information

man hinh dé di chuyén con tré va nhan nut
OK dé xac nhan lya chon hoac thay doi.



El Théng bao vé d6 phan giai 2.3 Thao dé va chan dé
Man hinh nay dwoc thiét ké dé hoat dong

t6i wu voi 36 phan giai gbc 1a 1920 x 1080 Kl Thao chan dé

@ 60 Hz. Khi dwoc chinh sang dd phan Trwde khi bat dau thao chan dé man

gidi khac, man hinh sé hién thj mot théng hinh, hay thwe hién theo cac hwéng dan
bao: Dung 1920 x 1080 @ 60 Hz dé dat bén dwéi dé tranh moi thiét hai hay chan
két qua tét nhét. thwong co thé xay ra.

Ban co thé tat théng bao hién thi do phan 1. Bat man hinh nam sap trén bé mat
gidi gbc tr muc Setup (Cai dat) trong min, can than dé tranh lam tray xwéc
menu OSD (Hién thi trén man hinh). hoac héng man hinh.

El Tinh nang vat ly
Nghiéng

2. An vao cac kep khoa dé thao chan dé
ra khdi tru dé.




& Note
This monitor accepts a T00mm x 100mm VESA-

Compliant mounting interface.




3. T6i wu héa hinh anh

3.1 SmartContrast

Kl polagi?

Coéng nghé ddc dao vdn linh hoat phan
tich ndi dung hién thj va tw déng téi wu
héa ty 1é twong phan cia man hinh LCD
dé mang lai d6 rd nét va trai nghiém xem
tdi wu, tdng mrc dén nén dé hién thi
nhirng hinh anh sang ré hon, sac nét hon
va sbng dong hon hay gidm mirc dén nén
dé hién thj ré hinh anh trén phong nén téi.
El Sao t6i phai can n6?

Ban muén hién thj ndi dung rd nét cung
cam giac thodi mai nhéat khi xem moi loai
néi dung. SmartContrast sé linh hoat chinh
do twong phan va mrc dén nén dé hién
thi nhirng hinh anh choi game hay video
cwe rd, sdng ddng va sac nét hay hién thi
ndi dung chi¥ ré rang dé doc cho cac (rng
dung van phong. Bang cach gidm viéc tiéu
thu dién clia man hinh, ban sé tiét kiém
dwoc chi phi ndng lwong va kéo dai tubi
tho cho man hinh cua ban.

El cach hoat dong?

Khi ban bat ché dd SmartContrast, n6 sé
phan tich ndi dung dang hién thij trong
thwe té dé chinh mau sac va mat do den
nén. Chrc nang nay sé linh hoat tng
do twong phan dé mang lai cho ban trai
nghiém giai tri tuyét voi khi xem video
hoac choi game.

3.2 Philips SmartControl Lite

Phan mém SmartControl Lite mé&i clia
Phillips cho phép ban diéu khién man hinh
qua giao dién dd hoa 3o tién dung. Cac
diéu chinh phtrc tap la nhivng gi thudc

vé qua khir vi phan mém than thién voi
ngwdi dung nay sé hudng dan ban qua
viéc tuy chinh d6 phan giai, hiéu chinh
mau, diéu chinh déng hé/géc pha, diéu
chinh diém trdng RGB (Dd-Luc-Lam), v.v...

10

Trang bi cdng nghé mai nhét vé thuat toan
16i xt ly va phan &ng nhanh, phdn mém
chay bang anh ddng bat mat thwong thich
véi Windows 7 nay san sang nang cao trai
nghiém cua ban v&i man hinh Philips!

Kl cai dat

« Thwc hién theo chi dan va hoan tat quy
trinh cai dat.

« Ban c6 thé kh&i ddng phan mém sau
khi hoan tat cai dat.

« Néu mudn khéi ddng sau, ban co thé
click phim tat phdn mém trén man hinh
nén ho&c thanh cdng cu may tinh.

PHILIPS

Wizard (Thuat si) khé&i déng lan dau

« Lan dau khi cai dat phan mém
SmartControl Lite, n6 sé tw ddng vao
Wizard (Thuat si) khéi dong lan dau.

 Thuéat si nay s& huwéng dan ban théng
qua viéc diéu chinh tirng bwéc vé hiéu
suat man hinh.

« Sau nay ban ciing c6 thé vao menu
Plug-in (B6 sung) dé bat thuat sf.

« Ban c6 thé chinh céac tuy chon khac
qua giao dién Standard (Chuan) ma
khéng can thuat sf.



1 smartControl 2 - Philips 22581 (C530715000001) (3) (%)

SmartControl Lite PHILIPS

Wizard

You'l need to calbrate your display to get the most
accurate color. We encourage you to use the simple
tuning process by selecting the Start Wizard button.
This process involves a series of steps that will let you
tune your display and save the settings.

1. Choose the Start Wizard button.

2. Follow the steps outlined in this process.

3. Savae your settings for future use.

"

Adjust Audio
\g Auto Pivat

T

Color Tnput

y L

ety

@ P
= B

Options Presets

ol

Multi Monitors

T !
il
o

Start Wizard

El Khéi dong bang giao dién Standard
(Chuén):

Menu Adjust (Diéu chinh):

« Menu Adjust (Diéu chinh) cho phép
ban chinh Brightness (D6 sang),
Contrast (D6 twong phan), Focus
(Trong tam), Position (Vi tri) va
Resolution (B phan giai).

« Ban c6 thé lam theo chi dan va thyc
hién diéu chinh.

» Lénh Cancel (Huy) sé héi ngwoi dung
xem ho c6 mubn huy tién trinh cai dat
hay khéng.

B SmartContral 2 - Philps 225B1 (C530715000001) 7| X,

SmartControl Lite PHILIPS

Brightness

Improperly adjusted Brightness wil resuft in a loss of
detailin darker image areas. Adjust the Brightness for
the best possble picture qualty.
1. Lower the Brightness to the minimum level.
2. Raise the Brightness to the desired level.
3. Adjust the Brightness as needed to achieve
an equal separation of the stripes.

]

o

Bn’ghit'n @55

@ Contrast
Color A
T~
e Focus Brightness 100
; - O+
\E Pasition
Opliors FF Undo Reset
Resolution

&

Help

11

B smartControl

SmartControl Lite

]

Adjust
Brightness
u Contrast
Color -~
o Focus
— Y
\g Posttion
Options F;
Resolution

&

Help

B smartcontrol

SmartControl Lite

Adjust

Brightness

o®

Contrast

Color %

- Focus

Posttion

Options FF

Resolution

Help

B smartcontrol

SmartControl Lite

|

Adiust
Brightness
W Contrast
Color R
—~
Focus

)
2

Opﬂo;'\s FF

Resolution

&

Help

2 - Philps 22581 (C530715000001) {F1X)
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Contrast

Adiust the Contrast (use the slider) to keep detais in
lighter image areas.
1. Raise the Contrast until the numbers 1 and 2
are no longer visble.
2. Slowly lower the Contrast to make the
numbers 2 and 3 reappear. The number 1
should remain barely visible.

Contrast 50
= 0 +

Undo Reset.

2 - Phiips 22581 (CS30715000001) {F}(X,
PHILIPS

Focus

Your display’s timing needs to be synchronized with
the video signal.

1. Choose Auto Setup.

2. If the vertical bands are still visible, you'l need

to adjust the Pitch.

Pitch: Try to make the vertical bands disappear.
Phase: Adjust to the brightest setting to minimize
movement on the screen.

pitch 50
= G/
Phase 17
= )
Undo Auto Setup
2 - Phiips 22581 (€S30715000001) {F}X
Position

Use the Position buttons to center the image on
your display. Using this tool, you can position the image
up, down, left, or right.

1. Use the Up/Down buttons to center the image

vertically.
2. Use the Left/Right buttons to center the image
harizontally.
Undo Resat
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SmartControl Lite PHILIPS

Resolution

You are currently at 2 Preferred resolution. For your
display to show crisp, clear text, colors, and images,
your display should be set to its Preferred resolution.

If your display is at a Non-Preferred resolution, click
on the Preferred button to change your resolution to

Preferred.
Adijust Q ™ Enable Resolution Notifier
- Brightness Picture Format
_— I~ 4:3 aspect ratio
Contrast
Color an
~
-, Focus
Position
Options Preferred

Resolution

: ‘||||||||||||||||||||||||||||||||||

Menu Color (Mau):

» Menu Color (Mau) cho phép ban chinh

mau RGB (DPoé-Luc-Lam), Black Level
(D6 t6i), White Point (Diém trang),
Color Calibration (Hiéu chinh mau).

« Ban c6 thé lam theo chi dan va thyc
hién diéu chinh.

»  Tham thdo bang bén duwoi dé hinh
dung co ban vé muc menu phu trén
thong tin nhap cda ban.

« Vidu C;olor Calibration (Hiéu chinh
mau sac):

" | SmartContral 2 - Phiips 22581 (€s30715000001) {Z)(%) '

SmartControl Lite PHILIPS

Black Level

Improperly adjusted Black Level wil result in 2 lass of
detailin darker image areas. Adjust the Black Level for
the best possble picture qualty.
1. Adjust the black level of the Red, Green, and
Blue using the sider bars.

RGB
ﬂ Red 50
Black Level = )} +
Green 50
Color White Point = Q +
ey Blue 50
—
Display Gamma = o )
\ w
. Undo Reset
Options Calibration

" W smartControl

SmartControl Lite

# "

RGB

Black Level

Whle Point

“
Display Garmma
LA

Calibration

" W smartControl

SmartControl Lite

# "

RGB
Black Level
White Point
Display Gamma

wy

Calibration

" W SmartControl

SmartControl Lite

Adiust RGB
Black Level
Color White Point
=
Display Gamma
Qptions Calbration

Help

2 - Philips 22581 (CS30715000001) !7?5'

PHILIPS

White Point

White Point is the point at which equal combinations
of red, green, and blue light at fullintenstty create
white, This effects the overall color quality. For the
most accurate colors click the Reset button then
select the White Point.
1. Please select the White Point value for the best
possble color quality.

White Point B500K
= O +

Undo Reset
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Display Gamma

Gamma is a component of the pixel brightness in a
display. A lower Gamma value produces brighter pixels
and a higher Gamma value produces darker pixels. The
default value for Gamma is 2.2.

To adjust Gamma, SmartImage must be set to Off.
Click the SmartImage OFf button before adjusting
Gamma.

1. Use the siider to select the desired Gamma.

Display Gamma 22
= o G
Smartlmage OFf
Undo Reset
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Calibration

Your display needs ta be properly calibrated in order

for it to produce the widest range of colors accurately.

Calibration should always take place as the fast tuning

step in the process. Remember to recaibrate any time

you make individual adjustments to image quality or

whenever you move your display to a new location.

. Make all other necessary adjustments to image
qualty first.

. Press Show Me to leam how to use the
calibration tools.

. Finally, press Start to begin the calibration
process.

¥ Enable color calbration

Color software designed in collaboration with Joseph
Holmes.

Protected by U.S. Patent No. 6,686,953

Show Me Start

Quick View



. “Show Me” (Cho t6i xem) sé bat
hwéng dan hiéu chinh mau.

. Start (Bat dau) - bat dau quy trinh
canh chinh mau qua 6 budéc.

. Quick View (Xem nhanh) tai cac hinh
anh trwdc/sau.

. Tr& vé giao dién chinh Color (Mau),
click nat Cancel (Huy).

Enable color calibration (Bat hiéu
chinh mau) - theo mac dinh la dwoc
bat. Néu khéng chon muc nay, ban
khéng dugc phép hiéu chinh mau va
tat cac nat khéi déng va xem nhanh.
Phai c6 théng tin bang sang ché trén
man hinh hiéu chinh.

Man hinh hiéu chinh mau dau tién:

Nut Previous (Trwéc) sé tat cho dén
khi man hinh mau th& hai bat Ién.
Next (Ké tiép) sé& chuyén vao muyc tiéu
tiep theo (6 muc tiéu).

Cudi cling, véo giao dién File>Presets
(File>Cai san).

Nut Cancel (Huay) sé dong giao dién
ngw&i dung (Ul) va tré ve trang bd
sung.
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Options>Preferences (Tuy chon>Uu
tién) - Sé chi hoat déng khi chon
Preferences (Ju tién) tr menu Options
(Tuy chon) sé xuéng. Trén man hinh
khéng hé tro twong thich véi chudn DDC/
Cl, chi c6 san céc thé Help (Tro gitp) va
Options (Tuy chon).
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SmartControl Lite PHILIPS
Preferences
You can use the following optians ta configure
SmartControl.
¥ Enable menu when right-cicking on desktop
4 ¥ Enable task tray menu
Preferences ¥ Run at system start-up
Set Transparency:
o @ 0% © 50% C 100%
Audio
Auto Pivot
T
Input
Wizard
2
Presets

« Hién thj cac cai dat wu tién hién hanh.
« O vira chon sé bat tinh nang nay. O
chon la nut bat/tat.

« Enable Context Menu (Menu bat thudc
tinh) trén man hinh nén PC sé duwoc
chon la (Bat) theo mac dinh. Enable
Context Menu (Menu bat thudc tinh)
hién thj cac Iwa chon SmartControl
Lite cho Select Preset (Chon cai san)
va Tune Display (Chinh man hinh)
trong menu thudc tinh khi click phai
vao man hinh nén. Disabled (D4 tat)
sé€ x6a SmartControl Lite khéi menu
thudc tinh click phai.

 Biéu twong Enable Task Tray (Bat

khay tac vu) dwoc chon la (Bat) theo
mac dinh. Menu bat thudc tinh hién thi
menu khay tac vu cho SmartControl
Lite. Click phai vao biéu twong khay
tac vu sé hién thj cac tuy chon menu
cho Help (Tr¢ giup), Technical Support
(H6 tro ky thuat), Check for Update
(Kiém tra cap nhat), About (V&) va Exit
(Thoat). Khi da tat Enable task tray



menu (Menu bat khay tac vu), biéu Options>Audio (Tay chon>Am thanh)
tu(_yng’ khay tac vu sé chi hién thi EXIT - Sé chi hoat déng khi chon Audio (Am
(THOAT). thanh) tir menu Options (Tuy chon) sb

« Theo mac dinh Run at Startup (Chay xuéng.

khi kh6i dong) sé duoc chon la (BAT). Trén man hinh khéng ho tro twong thich
Khi da tat, SmartControl Lite sé khong v&i chudn DDC/CI, chi ¢6 s&n cac thé
bat khi khot dong hoac nam trong Help (Tro gitp) va Options (Tuy chon).
khay téC Vu CéCh duy nhét dé, bét W smartControl 2 - Philips 22581 (C530715000001) (X
SmartControl Lite la tiv phim tat trén
man hinh nén hoac ttr file chwong _

trinh. B4t ky b6 cai dat sdn nao dé

using the slider.

chay khi kh&i dong sé hoat déng e ——
khang tai khi 6 nay khang duoc chon \Q oa
('Dé tét) A A‘udio

* Enable transparency mode (Bat ché | .
do trong suot) (Windows 7, Vista, XP).

Mac dinh 1a 0% Mo. . =

Options>Input (Tuy chon>Nhap) - Sé =

chi hoat déng khi chon Input (Nhap) ti &

menu Options (Tuy chon) sé xudng. Trén .

man hinh khéng hd tro twong thich voi = o @

chuan DDC/CI, chi c6 sn cac thé Help e

(Tro giup) va Options (Tuy chon). Tat ca .

cac thé SmartControl Lite khac déu khéng Help>User Manual (Tro gitip>So tay st

cb san. dung) - Sé chi hoat ddng khi chon User
— TR Manual (S6 tay st dung) t menu Help
SmartControl Lite PHILIPS (Tro giip) s0 xudng. Trén man hinh khong

ho tro twong thich vé&i chuan DDC/CI, chi
c6 san cac thé Help (Tro gitp) va Options

you can hook up twa different sources

SmartControl Lite PHILIPS

24

S

Wizard

®

at the same time. Use the Analog In and Digital In N
buttons which source you'd like to view. You uy C O n .
| are curre g the analog in image. -
IMPORTANT! u switch inputs SmartControl may B SmartControl 2 - Philips 22581 (€530715000001) (2)(X.
Q lose the ability to control your monitor. In this case you
Adiust o 4 may have to use the Input Select button on the front
of your monitor to switch back to the original input ¥
P before SmartControl functionality can be restored. Smartcontro' the pH I ll ps
i
B
Auto Pivot
\g User Manual
iy T If you need help setting up or operating SmartControl,
oer Tnput cick the Tech. Support button. You'l have the
N option to fill out an Assistance Form.
?B | You can also choo: e information about your
Wizard | software automatically attached to the assistance
g form. You'll need to be online to use this feature.
. 2
Options DTt Adjust ﬂ
r ol User Manual
Mutti Monitors \ f.
cd
L Update
=
Help Color |
=
4 Display ID
i | 3
Analog In Digital In \ i-l
2 System ID
Options

. 2 . P a , = #
« Hién thi giao dién huwéng dan Source = -

(Ngudn) va cai d&t ngudn nhap théng <«

tin hién hanh. -
« Trén cac man hinh nhap riéng, giao

dién nay sé khéng hién thi.

User Manual Tech. Support

14



Help>Version (Trg’ giup>Phién ban) - Sé
chi hoat déng khi chon Version (Phién
ban) tr menu Help (Tro gitp) sb xudng.
Trén man hinh khéng hé trg twong thich
v&i chudn DDC/CI, chi c6 s8n cac thé
Help (Tro giup) va Options (Tuy chon).

' SmartControl 2 - Philips 225B1 (C530715000001) 9 X

SmartControl Lite PHILIPS

User Manual

If you need help setting up or operating SmartContral,
click the Tech. Support button. You'l have the

User Manual Tech. Support

Menu nhay cam vé&i thudc tinh

Theo mac dinh, Context Sensitive Menu
(Chinh theo thudc tinh) sé dwoc Bat. Néu
da chon Enable Context Menu (Bat thudc
tinh) trong giao dién Options>Preferences
(Tuy chon>Uu tién) thi menu nay sé hién
thi.

£ @ SmartControl
Select Preset 4
Tune Display

Menu Thuodc tinh ¢c6 ba muc nhap:

* SmartControl Lite - khi da chon, About
Screen (V& man hinh) sé hién thj.

 Select Preset (Chon cai dat san) -
Cung cp menu cac muc cai san da
lwu theo trinh tw d& s dung ngay.
DAu kiém sé& hién thi muc cai sdn hién
da chon. Muc Factory Preset (Cai sén

15

goc) ciing c6 thé dwoc chon tir menu
sO xuong.

* Tune Display (Chinh man minh) - M&
bang diéu khién SmartControl Lite.

« Smartimage Lite - Kiém tra cac cai dat
hién hanh, Standard (Chuan), Internet,
Game.

Da bat menu khay tac vu
Ban c6 thé hién thi menu khay tac vu
bang céach click phai vao biéu twong
SmartControl Lite ttr khay tac vu. Click trai
sé bat rng dung.
Help
Technical Support
Check for Update
About

Exik

Khay tac vu c6 nam muc nhap:

* Help (Trg giup) - Truy céap file User
Manual (Sé tay st dung): M& file User
Manual (Sé tay s dung) qua ctra s
trinh duyét mac dinh.

«  Technical Support (H6 tro’ kj thuat) -
hién thi trang hd tro ky thuat.

« Check for Update (Kiém tra cap nhat)
- d&n nguoi dung dén Nén (rng dung
PDI va kiém tra phién ban cta ngudi
dung so v&i phién ban cé sdn maoi
nhéat.

« About (V&) - Hién thj théng tin tham
khado chi tiét: phién ban san pham,
thdng tin vé phién ban va tén san
pham.

« Exit (Thoat) - Pong SmartControl Lite.

Pé chay lai SmartControl Lite, hay chon
SmartControl Lite t* menu Program
(Chwong trinh), click déi biéu twong PC
trén man hinh nén hoac khdi dong lai hé
théng.



PHILIPS

SmartControl

EmartControl
‘ersion 3.20
chune-standard-R2007-01-04-1151-23
Copryright 1993-2007 Portrait Displays, Inc.
Patents Pending

Da tat menu khay tac vu

Khi da tat Khay tac vu trong thw muc

wu tién, chi con cd san lwa chon EXIT
(THOAT). Bé x6a hoan toan SmartControl
Lite khéi khay tac vu, hay tat Run at
Startup (Chay khi kh&i dong) trong
Options>Preferences (Tuy chon>Uu tién).

eLu’uy

Tét ca cac hinh minh hoa trong phan
nay chi dwoc dung dé tham khdo. Ching
t6i cd thé thay ddi phién ban phan mém
SmartControl ma khéng can théng bao
trwde. Vui long ludn truy cap trang web
chinh thirc cua Portrait tai www.portrait.
com/dtune/phl/enu/index dé tai vé phién
ban phan mém SmartControl méi nhét.
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4. Cac théng so ky thuat

Loai mat man hinh TFT-LCD
DPén nén LED
C& man hinh Réng 21.5 inch (54,6cm)
Hé sb co 16:9
Do pixel 0,248 x 0,248 mm
D6 sang 250 cd/m? or 200 cd/m?
Do twong phan thong minh 10,000,000:1
Do twong phan (chuén) 1000:1 or 600:1 for 200 nit or 3000:1 for MVA panel
Thoi gian dap ng (chuén) 5ms or 25ms for MVA panel
Do phan giai téi wu 1920 x 1080 @ 60Hz
170° (H)/ 160° (V) @ C/R > 10
Go6c xem or 90° (H) /65° (V) @ C/R > 10 for 200 nit
or 178° (H)/178° (V) @ C/R > 10 for MVA panel
Mau man hinh 16,7 triéu mau
Tbc d6 phat doc 56Hz - 76Hz
Tan sb ngang 30kHz - 83kHz
sRGB (Pd-Luc-Lam chudn) | CO
 Kétngi
DPAau vao tin hiéu DVI (KTS)(tuy chon), VGA (Analog)
Tin hiéu vao DPdng bd riéng, Ddng bd véi tin hiéu xanh luc

Tién ich

226V4LA: auto/v /A O/4 B/K )
226VAL:  auto/v /A 0/ < /0K Q)
Tiéng Anh, Tiéng Phap, Tiéng Plrc, Tiéng Tay Ban Nha,
Tiéng Y, Tiéng Nga, Tiéng Hoa Gian thé, Tiéng B6 Dao

Tién ich cho ngw&i dung

Ngén ngtr OSD (Hién thj trén

man hinh) Nha, Tiéng Thd Nhi Ky
Tién ich khac Khoa Kensington
Twong th[ch voi chuan Plug | DDC/CI, sRGB, Windows 7/Windows 8/Vista/XP, Mac
& Play (Cam vao la phat) OSX, Linux
Nghiéng -5/+20
226V4LA:
Ché d6 bat 21,45W (chuén), 25,65W (tbi da)
Ché d6 ngu (cho) 0,5W
Tat 0,5W
DPén bao LED nguén Ché d6 bat: Ché d6 Trang, Ch&/Ngu: Trang (nhap nhay)
Bo ngudn Thir néng, 100-240VAC, 50-60Hz
226V4L.:



Nguén dién

Ché do bat

21,5W (chuan), 23W (t6i da)
or 20,5W (chuén), 23,71W (tdi da) for 200 nit
or 23,6W (chuén), 27,82W (tbi da) for MVA panel

Ché dd ngl (chd)

0,5W

Tat 0,5W
Pén bao LED nguén Ché do bat: Ché dd Trang, Ch&/Ngu: Trang (nhap nhay)
B6 nguén Thtr néng, 100-240VAC, 50-60Hz

Sén pham kém theo dé giw
(Réng x cao x day)

514 x 388 x 213 mm

San pham khéng kém theo
dé gitr (R6ng x cao x day)
Trong lwong

514 x 320 x 48 mm

Sa&n pham kém theo dé gitv | 3,34kg
S?n .eham khéng kem theo 3,00kg
dé gitr

San pham ddng goi 4,59kg

Diéu kién hoat déng

binh gira cac sy c0)

Pham vi nhiét dé (hoat déng) | 0 °C -40 °C
Pham Yl nhiét dé (Khéng 220 °C - 60 °C
hoat dong)

Do &m twong dbi 20% - 80%
MTBF (Thoi lwong trung 30.000 gi&

Chi thi ROHS (Gi¢i han cac

Tuan thu va tiéu chuan
Phé chuan theo quy dinh
Vo6 ngoai

Mau

chét gay hai) &o

EPEAT Bac (www.epeat.net)

Thung dwng C6 thé tai ché 100%

Cac chét cu thé Thung dwng 100% khéng chira PVC BFR
Energy Star coO

CE Mark, FCC Class B, GOST, SEMKO, TCO Certified
(Only for selective models), UL/cUL, 1ISO09241-307,BSMI

|

DPen den hoac Trang

L&p son ngoai

Bong lang/Hoa van

© Ghi chu

1. Vang hay bac EPEAT chi c6 hiéu lyc tai noi ma Philips da dang ky sén pham. Hay truy
cap www.epeat.net dé biét tnh trang dang ku tai quoc gia cua ban.

N

D@ liéu nay chju sw thay ddi ma khéng can théng bao trudc. Truy cap www.philips.com/
support dé tai vé phién ban t& roi méi nhét.
18




4.1 Ché d¢ do phan giai & cai
dat san

z
A=

El D6 phan giai téi da
1920 x 1080 @ 60 Hz (déu vao analog)
1920 x 1080 @ 60 Hz (dau vao KTS)

E1 Do phan giai khuyén dung
1920 x 1080 @ 60 Hz (dau vao KTS)

Tansd Do phangidi Tan sb doc

ngang (kHz) (Hz)
31,47 720 x 400 70,09

31,47 640 x 480 59,94

35,00 640 x 480 66,67

37,86 640 x 480 72,81

37,50 640 x 480 75,00

37,88 800 x 600 60,32

46,88 800 x 600 75,00

48,36 1024 x 768 60,00

60,02 1024 x 768 75,03

4477 | 1280x720 | 59,86

63,89 1280 x 1024 60,02

79,98 1280 x 1024 75,03

55,94 1440 x 900 59,89

70,64 1440 x 900 74,98

65,29 1680 x 1050 59,95

67,50 1920 x 1080 60,00

& Ghichu

Lwu y rdng man hinh cta ban hoat déng
t6t nhat & d6 phan giai gbc 1920 x 1080
@ 60Hz. D& c6 chét lwong hién thj tét
nhat, hay dung dé phan giai khuyén nghi
nay.
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5. Quan ly nguon dién

Néu ban da cai dat card man hinh hay
phan mém twong thich chudn VESA DPM
vao PC, man hinh ¢6 thé tw dong giam
tiéu thu dién khi khéng st dung. Néu phat
hién nhap t ban phim, chudt hay thiét bj
nhap khac, man hinh sé “hoat dong” tw
dong. Bang sau day sé hién thi mie tiéu
thu dién va cach truyén tin hiéu cta tinh
nang tiét kiém dién tw dong nay:

226VA4LA:

Dinh nghia quan ly nguén dién

Ché do Video Ddng bo| Bdng | Ngudn dién | Mau dén
VESA ngang | bd doc str dung LED
" - ; ; 21,45W 2
Hoat dong| BAT Co Co (chuén) Trang
£ om Trang

Che o | 141 | Knang | Khong |0,5W (chun)| (Nhép

ngu (cho) nhéy)
Tét TAT - - |0,5W (chuan)| TAT

226VA4L.:

Dinh nghia quan ly nguén dién

Ché do Video Ddng bo| Bdng | Ngudn dién | Mau dén
VESA ngang | bd doc str dung LED
21,5W
(chuan)
or 20,5W
. . ) : (chuén) for 5
Hoat dong| BAT Co Co 200 nit Trang
or 23,6W
(chuan) for
MVA panel
_ Trang
Che o | 141 | Knong | Khang | 0,5W (chudn)| (Nh4p
ngu (cho) nhéy)
Tét TAT - - |0,5W (chuan)| TAT

Cai d&t sau day dwoc dung dé& do marc
tiéu thu dién trén man hinh.

« D6 phan giai gbc: 1920 x 1080

* Do twong phan: 50%

* D6 sang: 250 nit or 200 nit

*  Nhiét d6 mau: 6500k v&i kiéu mau
trang day dua

& Ghichu
D liéu nay chiu sy thay doi ma khdng

20
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6. Théng tin quy dinh

Lead-free Product

Lead free display promotes
environmentally sound recovery
and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community’s
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

Congratulations!

This product is TCO Certified - for Sustainable
T

TCO Certified is an international
third party sustainability certification

for IT products. TCO Certified.
ensures that the manufacture, use and recycling
of IT products reflect environmental, social and
economic responsibility. Every TCO Certified
product model is verified by an accredited
iIndependent test laboratory.

This product has been verified to meet all the
criteria in TCO Certified, including:

* Corporate Social Responsibility
Socially responsible production - working
conditions and labor law in manufacturing
country

* Energy Efficiency
Energy efficiency of product and power
supply. Energy Star compliant, where
applicable

*  Environmental Management System
Manufacturer must be certified according
to either ISO 14001 or EMAS

e Minimization of Hazardous Substances
Limits on cadmium, mercury, lead
& hexavalent chromium including
requirements for mercury-free products,

21

halogenated substances and hazardous
flame retardants

* Design for Recycling
Coding of plastics for easy recycling. Limit
on the number of different plastics used.

* Product Lifetime, Product Take Back
Minimum one-year product warranty.
Minimum three-year availability of spare
parts. Product takeback

* Packaging
Limits on hazardous substances in product
packaging. Packaging prepared for recycling

* Ergonomic, User-centered design
Visual ergonomics in products with a
display. Adjustability for user comfort
(displays, headsets) Acoustic performance
— protection against sound spikes
(headsets) and fan noise (projectors,
computers) Ergonomically designed
keyboard (notebooks)

 Electrical Safety, minimal electro-magnetic
Emissions Third Party Testing
All certified product models have been
tested in an independent, accredited
laboratory.

A detailed criteria set is available for download
at www.tcodevelopment.com, where you can
also find a searchable database of all TCO
Certified IT products.

TCO Development, the organization behind
TCO Certified, has been an international
driver in the field of Sustainable IT for 20 years.
Criteria in TCO Certified are developed in
collaboration with scientists, experts, users

and manufacturers. Organizations around

the world rely on TCO Certified as a tool to
help them reach their sustainable [T goals.We
are owned by TCO, a non-profit organization
representing office workers. TCO Development
is headquartered in Stockholm, Sweden, with
regional presence in North America and Asia.

For more information, please visit
www.tcodevelopment.com



I[n Technology for you and the planet
CERTIFIED

(Only for selective models)

EPEAT

(Www.epeat.net)

The EPEAT (Electronic
Product Environmental
Assessment Tool) program
evaluates computer
desktops, laptops, and monitors based on 51
environmental criteria developed through

an extensive stakeholder consensus process
supported by US EPA.

el

X

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT’S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

«  EN60950-1:2006+A11:2009+A1:20
10+A12:2011 (Safety requirement of
Information Technology Equipment).

* EN55022:2010 (Radio Disturbance
requirement of Information Technology
Equipment).

*  EN55024:2010 (Immunity requirement of
Information Technology Equipment).

*  EN61000-3-2:2006 +A1:2009+A2:2009
(Limits for Harmonic Current Emission).

*  EN61000-3-3:2008 (Limitation of Voltage
Fluctuation and Flicker) following provisions
of directives applicable.

«  2006/95/EC (Low Voltage Directive).
« 2004/108/EC (EMC Directive).

*  2009/125/EC (ErP Directive, EC No.
1275/2008 Implementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on I1SO9000
level.

The product also comply with the following
standards

«  1509241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

* GS EK1-2000:2011 (GS mark requirement).

*  prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

*  MPR-II (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

« TCO CERTIFED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions..



Energy Star Declaration

(Www.energystargov)

As an ENERGY STAR® Partner, we
have determined that this product
meets the ENERGY STAR®
guidelines for energy efficiency.

ENERGY STAR

& Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission
(FCC) Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

» Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

* Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

Commission Federale de la
Communication (FCC Declaration)

& Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numeériques de class B,aux termes de
I'article 15 Des regles de la FCC. Ces
limites sont concues de facon a fourir
une protection raisonnable contre les
interférences nuisibles dans le cadre d'une
installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.



6. Thong tin quy dinh
Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliere. Si cet appareil est
la cause d'interférences nuisibles pour
la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, I'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer 'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

* Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur.

¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

Toutes modifications n'ayant pas regu
I'approbation des services compétents

en matiere de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTETOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.
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EN 55022 Compliance (Czech Republic
Only)

This device belongs to category B devices as described in EM 55022, unless it is spacifi-
cally stated that it is a Class A devios on the spacilication labal. The following applias to
devices in Class A of EN 55022 (redius of protection up to 30 matars). The ussar of tha
device is obliged 1o take all stape necessary to remove scurces of intarferance io tala-
communication or other devices.

Pokud nani na typowem Btithu poditade uvedano, #a spadé do do ffidy A podle EN 55022,
spadd automaticky do tfidy B podie EN 55022, Pro zafizeni zafazend do tfidy A (chranné
pésma 30m) podie EN 55022 platl nésledujicl. Dojde-l k rulsni talsknmuniketnich nebo
Jinjch zafizani jo u3vatal povinnen provést takovd opatfgnl, aby nebani odstranil,

Polish Center for Testing and
Certification Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer; and so on)
should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/T-42107
and PN-89/E-06251.

Wymagania Polskiego Centrum Badan i Certyfikacyi

Urradzende powinno byé zasitane 2 priazds 2 preybgeronym obwodem ochronmym (gniazdo 2
kalkiem )y, Wapdlpracuggee o soby ursgdoenia (komputer, monstor, drukarka) powiny byd zasilane
# Lo shmepn drddla.

Imil.nlul:J:Ln:]uklry\:mupnmiuwmnu powinna mwierad w ]'Il)’l!\.ltlll.{.il_' Eaowrym ] achrang
proed rwarciami, w postaci beepiecenika o wartedcl smamionowe] mie wigkszej ni 16A (amperiw).
Wooalu calkoayitego wylacrania u[t:u]n fikh # Slect zasilania, ||:1IL{:,- wylal wivezks kabla
easilajneege 2 prinedka, kidre powinno jdowsd sig w poblizu ureydeenda © byd Barwo destgpme.

Znak berpleesefstwa "B” potwiendes spodaodl wresdrenia » wymsgandaiml bezplecefistva
whytkowanma zawartyml w FR-SLTAI107 1 PN-REAGZE].

Pozostale instrukcje bezpieczensiva

* Mie maledy whywad wiyceek adapierowvch lub wuwad kedka obwedw ochrommego = wiyceki.
Tzl komseiene jes whyews preadhatacea to naledy whyé preedlufaces 3-ryvlowego 2
prrawidlowa potscronymm praewoden ochmonnymn.

Sysbem knmpuh_mn v maleiy zaberpiccryd pcm.\'J maghymi, chwilowymi werostami tub spad-
ki mapigeia, wkywajac climinatar preepicd, uresdzenia dopasawajacega luh
beraklocenowega mnodia caglania

* Maleky upewnid sig, sby nie nde lekalo na kablach sysieemu kompuierowego. oraz aby kable nie
byly witlexacaone w ||1|L|:LI.| gidese modna byloby fa nle nadeplywad lub potykad <lg o me.

* Mie maledy roclewad napogio an meych plyndo e system kompuierowy.

*  MNie naledy wiychat zadnyeh preednnstion da atwordw systenm kemputercwepa, gdyi mode
1o spowodowat pudar lub poragenie prydem, popraes zwarcie clementdw wewngtrznych

* System kompaterowy powinden enapdowad sig 2 dala od greejnikiw o drédel clepla. Poradro,
mie maleey blokawad atworaw wentylacyjnych. Mabeidy unzkac kladeenza luinych papserdw posd
kamputer oz umiesrczania kampubera w clasaym migjscw bes madliwasc cyrkulacji powi-
elrra wokal nicge.



North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS,

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR

ST@MTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
NELHENERZITE
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Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schdden durch Réntgenstrahlen" festgelegten
Vorschriften.

Auf der Rickwand des Gerétes befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Stoérstrahlern nach Anlage
Il @ 5 Abs. 4 der Rontgenverordnung erflllt sind.

Damit |hr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, daf3

1. Reparaturen nur durch Fachpersonal
durchgefihrt werden.
nur original-Ersatzteile verwendet werden.

3. bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Grinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf|
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhdhte Augenbelastung bei zu
geringem Zeichenkontrast waren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 7/0dB (A) oder
weniger.

7N ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.



6. Thong tin quy dinh
China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.

s ABROHS
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EU Energy Label

¢ "m‘ AN s
| Wen

J
L2

The European Energy Label informs you on
the energy efficiency class of this product.
The greener the energy efficiency class of this
product is the lower the energy it consumes.

On the label, you can find the energy efficiency
class, the average power consumption of

this product in use and the average energy
consumption for 1 vyear.

&Note

The EU Energy Label will be ONLY applied on
the models bundling with HDMI and TV tuners.



7. Dich vu cham séc
khach hang va bao
hanh

7.1 Chinh sach 16i diem anh
man hinh phéng cua Philips
Philips cb gang cung cap cac san pham
chét lwong cao nhét. Chung t6i ap dung
mot s6 quy trinh san xuét tién tién nhét
trong linh vire va thwe hién quy trinh kiém
tra chéat lwong nghiém ngat. Tuy nhién, cac
16i diém anh hay diém anh con trén man
hinh TFT dung trong cac man hinh phang
déi khi khéng thé tranh khaéi. Khéng nha
san xuat nao cé thé ddm bao rang moi man
hinh sé khong co cac I6j diém anh, nhung
Philips dam bao rang bat ky man hinh nao
c6 mot sO 16i khdng thé chap nhén sé dwoc
stra chira hoac thay méi dwa vao chinh
sach bao hanh. Théng bao nay giai thich
nhirng kiéu I16i diém anh khac nhau va dinh
nghfa cac mirc 16i c6 thé chap nhan cho
moi kiéu 16i. Dé hwdng dich vu stra chira
hay thay the theo chinh sach bao hanh, so
lwong 16i diém anh trén man hinh TFT phai
vuwot qua cac muc chép nhan nay. Vi du,
khéng qua 0,0004% diém anh con trén man
hinh cé thé bi 16i. Ngoai ra, Philips tham
con dat ra cac tiéu chuan chét lwong cao
hon cho mét s6 kiéu hay két hop 16i diém
anh von dé nhin thay hon céc kiéu 16i khac.
Chinh sach nay co hiéu Iyc trén toan cau.

ez 2 <
diem diém diém )
anh phu anh phu anh phu

RGBS
dlem

anh

Dlem anh va diém anh con

Diém anh hay phan t&r &nh gdm ba diém
anh con trong cac mau chinh do, luc va
lam. Nhiéu diém &nh cling tao thanh hinh
anh. Khi moi diém anh con ctia mét diém
anh sang lén, ba diém anh con c6 mau séc
cung hién thi nhw mot diém anh trang don
1&. Khi moi diém anh con t6i m&, ba diém
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anh con c6 mau séc cuing hién thi nhu mét
diém anh den don 1&. Nhirng két hop diém
anh con sang va tbi khac hién thi nhw cac
diém anh don 1& tlr nhirtng mau khac.

Cac kiéu 16i diém anh

Céc 16i diém anh va diém anh con hién thj
trén man hinh theo nhirng cach khac nhau.
C6 hai kiéu 16i diém anh va nhiéu 16i diém
anh con trong méi kiéu 16i.

Cac 16i cham sang

Céc 16i chdm sang hién thi dwoi dang cac
diém anh hay diém anh con vén ludn sang
hay “bat”. Nghia 1a méi chdm sang 1a mot
diém anh con von ndi [én trén man hinh khi
man hinh hién thj kiéu hinh t6i m&. C6 céc
kiéu 16i chAm sang.

- A

- %

Mét diém anh con sang d3, luc hay lam.

/ N

I C

N Y
Hai diém anh con sang gan nhau:

- Do +Lam =Tim

- Do + Luc = Vang

- Luc + Lam = Luc lam (Lam nhat)
s ™




Ba diém anh con sang gan nhau (mét diém
anh trang).

& Ghichu

Chém sang dd hay lam phai sang hon
50% so v&i cac chdm xung quanh trong
khi chdm sang luc sang hon 30% so v&i
cac chdm xung quanh.

Cac 16i cham den

Céc 16i chAm den hién thi dwéi dang cac
diém anh hay diém anh con vén luén téi
m& hay “tat”. Nghia 1a méi cham tdi mo
la mot diém anh con vén ndi lén trén man
hinh khi man hinh hién thj kiéu hinh sang.
C6 cac kiéu 16i chadm den.

4 N

a I N

Do gan cua cac 16i diém anh

Vi céc 16i diém anh va diém anh con cla
cung kiéu 16i von gan véi mot kiéu 16i khac
co6 thé dé nhin thay hon, Philips cling néu
ré cac dung sai vé dé gan cua I6i diem anh

4 N

a N

\_ /

Dung sai 16i diém anh

Dbé hwéng dich vu stra chiva hay thay

thé do céac 16i diém anh trong thoi han

bao hanh, man hinh TFT trong man hinh
phéng Philips phai c6 cac 16i diém anh hay
diém &nh con vwot qua nhirng dung sai
néu trong cac bang sau.

\ %
LOI CHAM SANG MUC CHAP NHAN
1 diém anh con sang 3
2 diém anh con sang gan nhau 1
3 diém anh con sang gan nhau (mot diém anh trdng) 0
Khoang céach gitra hai 16i chAm sang* >15mm
Téng sb 16i chAm sang ctia moi kiéu 16i 3

LOI CHAM DEN
1 diém anh con téi mo

MU’C CHAP NHAN
5 hoac it hon

2 diém anh con t6i m& gan nhau 2 hoéc it hon
3 diém anh con t6i m& gan nhau 0
Khoang céach gitra hai 16i chdm den* >15mm
Tbng sb 16i chAm den cGia moi kiéu 16i 5 hodc it hon

TONG SO LOI CHAM

MUC CHAP NHAN

Téng sb 16i chAm sang hay den ctia moi kiéu 16i

5 hoac it hon

& Ghichu

1. 1 hay 2 16i diém anh con gan nhau = 1 16i chAm

2. Man hinh nay tuan thi chuan 1S09241-307. (1IS09241-307: Yéu cau, phan tich vé hiéu
nang va cac phwong phap kiém tra tuan thi cho man hinh dién t)

3. 1S09241-307 Ia tiéu chuan tiép theo cua tiéu chuan 1ISO13406 c(, von da bi hiy b béi
T chirc Tiéu chudn héa Quéc té (1ISO) vao ngay: 13-11-2008.



7.2 Cham séc khach hang & Ché ddé bao hanh

Dé cé théng tin chi tiét vé chinh sach bao hanh va yéu cau hé tro thém dwoc ap dung cho
khu vire cta ban, vui long truy cap website www.philips.com/support. Ban ciing c¢ the lién
hé v&i Trung tdm cham soéc khach hang dia phwong cta Philips theo s6 dién thoai dudi
day.

Théng tin lién lac cho khu vrc TAY AU:

Quéc gia ASC (Trung tam S6 cham séc khach
dich vu uy quyén) hang

Germany Siemens 1&S +49 01803 386 853 €0.09

United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
Ireland Invec Scotland +353 01 601 116 Local call tariff
Spain Eatsa Spain +34 902 888 785 €0.10

Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 €0.09

Greece Allman Hellas +30 00800 3122 1223 Free of charge
Italy A-novo +39 840 320 041 €0.08
Netherlands E Care +31 0900 0400 063 €0.10
Denmark A-novo +45 3525 8761 Local call tariff
Norway A-novo +47 2270 8250 Local call tariff
Sweden A-novo +46 08 632 0016 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Austria Siemens 1&S +43 0810 000206 €0.07
Belgium E Care +32 078 250851 €0.06
Luxembourg E Care +352 26 84 30 00 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
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Théng tin lién lac cho khu viec TRUNG VA DONG AU:

Quéc gia Trungtam  ASC (Trung tam dich vu g4 opa s6¢ khach hang
dich vu uy quyeéen)
Belarus NA IBA +37517 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Estonia NA FUJITSU +372 6519900
Latvia NA “ServiceNet LV” Ltd. +371 7460399
Lithuania NA UAB “Servicenet” +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
Serbia & iy Kim Tec d.0.0. +381 11 20 70 684
Montenegro
Slovenia NA PC H.and +386 1 530 08 24
_ NA Comel +380 562320045
Ukraine :
NA Topaz-Service Company | +38 044 245 73 31
Russi NA CPS +7 (495) 645 6746 (for repair)
ussia
NA CEEE Partners +7 (495) 645 3010 (for sales)
Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832
Czech Rep. |NA Asupport 800 100 697
NA Serware +36 1 2426331
Hungary : :
NA Profi Service +36 1 814 8080

Théng tin lién lac cho khu viec CHAU MY LATINH:
Trung tam dich vu

Qubc gia

Brazil

Argentina

Vermont

S6 cham séc khach hang
0800-7254101

0800 3330 856

Théng tin lién lac & Trung Quéc:

Trung Québc

Sb cham séc khach hang: 4008 800 008

Théng tin lién lac cho khu viec NAM MY:

Quéc gia Trung tam Al C =0, S6 cham séc khach hang

dich vu Uy quyén)
U.S.A. EPIl-e-center | Qwantech (877) 835-1838
Canada Supercom Supercom (800) 479-6696
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Théng tin lién lac cho khu virc Chau A TBD/Trung Péng/Chau Phi (APMEA):

Quéc gia

Trung tam

dich vu

ASC (Trung tam dich vu
uy quyen)

S6 cham séc khach hang

Australia NA AGOS NETWORK PTY LTD | 1300 360 386
New Zealand | NA Visual Group Ltd. 0800 657447
Hong Kong / NA Smart Pixels Technology Hong Kong:Tel: +852 2619 9639
Macau Ltd. Macau:Tel: (853)-0800-987
. Tel: 1 800 425 6396
India NA REDINGTON INDIALTD SMS: PHILIPS to 56677
Indonesia NA PT. Gadingsari elektronika Tel: 62 21 75909053, 75909056,
Prima 7511530
South Korea |NA PCS One Korea Ltd. 080-600-6600
, After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Pakistan NA Philips Consumer Service (9221) 2737411-16
Philips Electronics
Singapore NA Singapore Pte Ltd (Philips | (65) 6882 3999
Consumer Care Center)
PCCW
Taiwan Teleservices |FETEC.CO 0800-231-099
Taiwan
Thailand  |NA ﬁ’gs Computer System Co., | g69) 034-5408
South Africa | NA Syvara Technologies Pty g6 0000 888
Unllted Arab NA AL SHAHD COMPUTER 00971 4 2276525
Emirates L.L.C
Israel NA Eastronics LTD 1-800-567000
: : +84 8 38248007 Ho Chi Minh City
Vietnam NA EE;S:;V'T_? dlnformatlc +84 5113.562666 Danang City
pany . +84 5113.562666 Can tho Province
I : (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 to 60
Sri Lanka NA no d@stributor and/or service
provider currently
Distributor: Computer
880-2-9141747, 9127592
Bangladesh |NA gstt;rce Ltd (warranty buy- 880-2-8128848 / 52
Nepal NA Distributor: Syakar Co. Ltd 977-1-4292395
(warranty buy-out)
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) 855-023-999992

(warranty buy-out)
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8. Khac phuc sw co &
Hoi Dap

8.1 Khac phuc sw cb

Trang nay giadi quyét cac sy cb vén ngudi
dung c6 thé khac phuc. Néu sw ¢cb van
tiép dién sau khi ban da tht» dung céac giai
phap trén trang nay, hay lién hé voi dai
dién dich vu khach hang cua Philips.

Bl Ccac sw cd thwong gap

Khéng cé hinh anh (Pén LED nguén

khong sang)

Dam bdo da cadm day ngudn vao 6
cam dién va mat sau cdia man hinh.

«  Trudc tién, ddm bao nat nguon &
mat trwedc man hinh nam & vi tri OFF
(TAT), sau d6 day nut sang vi tri ON
(BAT).

Khéng cé hinh anh (Pén LED nguén

sang trang)

+  Dam bao da bat may tinh.

« Pam bao cap tin hiéu da dwoc két nbi
dung cach v&i may tinh cda ban.

. Dém be}o cap man hinh khong co6 cac
ch,éu cam bi cong trén mat két noi.
Néu cé, hay stra hay thay ma&i cap.

+ C6 thé da bat tinh nang Tiét kiém
nang luvong

Man hinh théng bao

Attention

Check cable connection

«  Dam bao cap man hinh da duoc két
ndi dung cach v&i may tinh cua ban.
(Cling tham khao Hwdng dan khéi
ddng nhanh).

« Kiém tra xem cap man hinh c6 cac
chau c&m bi cong hay khéng.

« Dam bao da bat may tinh.
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Nut AUTO (Tw dong) khéng hoat déng
Chwrc ndng tw ddng chi ap dung & ché
dd VGA- Analog. Néu khéng hai long
véi két qua, ban c6 thé thuc hién cac
diéu chinh tha céng qua menu OSD
(hién thi trén man hinh).

& Ghi chu
Chtrc nang Auto (Tw déng) khong ap dung
& ché dd DVI-KTS vi n6 khéng can thiét.

Cac dau hiéu vé khéi hay tia Itra c6 thé

nhin thay ’ '

* Khong thwe hién bat ky buéc khac
phuc sw cb nao

+ Ngat ngay két ndi man hinh khi 6
cam dién chinh cho an toan

* Lién hé ngay v&i dai dién dich vu
khach hang cua Philips.

Bl Cac sw cd hinh anh

Hinh anh khéng nam giira tam man

hinh

* Chinh vi tri hinh anh qua chirc nang
“Auto (Tw ddng)” trong cac nut diéu
khién chinh trén menu OSD.

» Chinh vi tri hinh anh qua Phase/Clock
(Géc pha/Pdng ho) clia Setup (Cai
dat) trong cac nut diéu khién chinh
trén menu OSD. N6 chi ¢6 hiéu lwc &
ché d6 VGA.

Hinh anh rung Ién trén man hinh

« Kiém tra xem cap tin hiéu da dwoc
cam chat dung cach vao bang mach
dd hoa hay may tinh hay chua.

Hién thj hién twong chap chéon doc

» Chinh hinh anh qua chtrc nang “Auto
(Tw d6ng)” trong cac nut diéu khién
chinh cia menu OSD.



* Loai bd cac vach doc qua Phase/
Clock (Géc pha/Béng hd) cla Setup
(Cai dat) trong cac nut diéu khién
chinh ctia menu OSD. N6 chi c6 hiéu
lwc & ché d6 VGA.

Hién thj hién twong chap chén ngang

=

W)

* Chinh hinh &nh qua chtrc nang “Auto
(Tw doéng)” trong cac nut diéu khién
chinh cia menu OSD.

* Loai bd cac vach doc qua Phase/
Clock (Géc pha/Bdng hd) ctia Setup
(Cai dat) trong cac nut diéu khién
chinh ctia menu OSD. N6 chi c6 hiéu
lwc & ché d6 VGA.

Hinh anh hién thi nhoe, khéng ré hoic

qua mo

* Chinh d6 twong phan va dd sang trén
menu Hién thi trén man hinh (OSD).

Hién twong “anh ao”, “anh thir néng”
hay “anh béng ma” van hién thj sau khi
da tat nguon.

« Hién thj lién tuc cac &nh tinh trong mot
thdi gian dai c6 thé gay ra hién twong
“anh thtr néng”, con dwoc goi la “anh
ao” hay “anh béng ma”, trén man hinh
cta ban. “Anh thir néng”, “Anh a0”
hay “Anh bong ma” 14 hién twong phd
bién trong céng nghé man hinh LCD.
Trong hau hét cac trudng hop, hién
twong “anh th&r ndng” hoac “anh ao”
hay “anh béng ma” sé& dan dan bién
mat sau mot thdi gian man hinh bj
ngat dién.

e Ludn bat trinh bao vé man hinh
chuyén déng khi ban khéng st dung
man hinh.

* Ludn bat &rng dung lam md&i man hinh
dinh ky, néu khéng, man hinh LCD
clia ban sé& hién thi nhixng ndi dung
tinh khéng thay déi.
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« Cac hién twgng “anh thtr néng” hay
“anh ao” hay “anh béng ma” sé khéng
biét mét va ban can mang man hinh
di stra. Thiét hai nhw trén khéng nam
trong chinh sach bao hanh cda ching
toi.

Hinh hién thj bién dang. Van ban bi m&

hoac nhoe.

» Cai do phan giai man hinh may tinh
sang cung ché do voi dd phan giai
man hinh gbc khuyé&n dung ctia man
hinh LCD.

Cac cham luc, d6, lam, den va trang

hién thi trén man hinh

« Cac chdm con lai 1a dac tinh théng
thwéng clia man hinh tinh thé 16ng
dung trong cong nghé ngay nay. Vui
long tham khao chinh sach diém anh
dé biét thém théng tin.

Pén “bat nguon” qua sang va gay chéi

mat

« Ban c6 thé chinh dén “bat ngudn” qua
Cai dat dén LED nguén trong cac nut
diéu khién chinh clia menu OSD.

Pé duwoc tro giup thém, hay xem danh
sach Trung tdm théng tin khach hang
va lién hé v&i dai dién dich vu cham so6c
khach hang cuta Philips.



8.2 Hoi bap chung
H1: Khi cai cai dat man hinh, téi can
lam gi néu man hinh hién thj
“Cannot display this video mode”
(Khéng thé hién thi ché d6 video
nay)?

Dap: b6 phan giai khuyén dung cho man

hinh nay la: 1920 x 1080 @60 Hz.

« Ngat tit ca cac cap roi két néi PC voi
man hinh ma ban da dung trwéc do.

* Trong Windows Start Menu (Menu
khéi dong Windows), chon Settings/
Control Panel (Cai d&t/bang diéu
khién). Trong Control Panel Window
(Ctra sb bang diéu khién), chon biéu
twong Display (Man hinh). Bén trong
Display Control Panel (Bang diéu
khién man hinh), chon thé “Settings”
(Cai dat). Trong thé cai dat, trong 6
co tén “desktop area (vung man hinh
nén)’, chuyén thanh trwot sang mac
1920 x 1080 pixels.

+ M@ thé “Advanced Properties” (Thubc
tinh ndng cao) va cai Mc cap nhat
(Refresh Rate) sang 60Hz réi click
OK.

» Khéi dong lai may tinh va lap lai buwéc
2 va 3 dé kiém tra xem PC cla ban da
dwoc cai sang mire 1920 x 1080 @60
Hz hay chua.

« Tat may tinh, ngét két ndi man hinh
cii va két néi lai man hinh LCD Philips
cla ban.

« Tat man hinh réi bat lai PC.

H2: Mcdrc cap nhat khuyén dung cho
man hinh LCD la bao nhiéu?

Mcrc cap nhat khuyén dung cho man
hinh LCD la 60Hz. Néu co bat ctr
hién twong nhiéu nao trén man hinh,
ban cé thé cai dat mirc nay sang
75Hz dé kiém tra xem md&c mai nay
c6 loai bé dwoc hién twong nhiéu
hay khong.

Dap:
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H3: Cac file .inf va .icm trén dia CD
la gi? Lam thé nao dé cai dit cac
driver (.inf va .icm)?

Dap: Day la cac file driver cho man hinh
clia ban. Thuc hién theo cac chi dan
trong sb tay st dung dé cai dat cac
driver nay. May tinh c6 thé yéu cau
ban cai cac driver man hinh (file .inf
va .icm) hoac |ap dia driver khi ban
cai dat man hinh Ian d4u. Thwce hién
theo cac chi dan dé 1ap (dia CD kém
theo) thung dwng man hinh nay. Cac
driver man hinh (file .inf va .icm) sé
dwoc cai dat tw dong.

H4:
DPap:

Lam thé nao dé chinh dé phan giai?
Card video/driver dé hoa cta ban

va man hinh sé cling quyét dinh

cac do phan gidi c6 sén. Ban co thé
chon d6 phan giai mong mudn trong
Control Panel (Bang diéu khién)

ctia Windows® qua thé “Display
properties” (Thudc tinh man hinh).

H5: Diéu gi sé xay ra néu téi quén cac
thao tac tiép theo khi dang diéu
chinh man hinh qua menu OSD?
Chi can nhan nut OK rdi chon
“Reset” (Cai dét lai) d& phuc héi moi
cai dat mac dinh gbc.

Dap:

H6: Man hinh LCD c6 kha ndng chéng
tray xwéc?

N6i chung ban khéng nén dé bé mat
man hinh va cham qua muc véi cac
vat khac hay va bao vé né khéi cac
vat dung sac hay cun. Khi cdm man
hinh, dam bao khéng dung strc ép
hay lwvc manh Ién phia bé mat man
hinh. Diéu nay c6 thé anh hwdng
dén cac diéu kién bao hanh cta ban.

Dap:

T6i nén lau man hinh LCD nhw thé
nao?

Dap: Dé lau théng thwdng, hay st dung
khan sach va mém. Dé lau ky, hay
dung cén isopropyl. Khéng dung
cac dung méi khac nhw con étylic,
ethanol, axeton, hexan, v.v...

H7:



H8: Toi co thé thay déi cai dit mau
sac cho man hinh?
Dap: Di nhién, ban c6 thé thay dbi cai

dat mau sac qua nut diéu khién trén
menu OSD theo cac quy trinh sau,

. Nhén “OK” dé hién thi menu OSD
(Hién thij trén man hinh)

. Nhan “Down Arrow” (Mdii tén
xudng) dé chon tuy chon “Color”
(Mau) r6i nhan “OK” dé vao cai dat
mau; c6 ba lwa chon mau nhw sau.

1. Color Temperature (Nhiét d6 mau);
Hai cai dat gdbm 6500K va 9300K.
V&i cac cai dat trong pham vi
6500K, man hinh sé hién thj “néng
v&i tin hiéu mau dé-trang", trong khi
nhiét dé 9300K tao ra “mat vaoi tin
hiéu mau lam-trang”.

2. sRGB (P&-Luc-Lam chuén); day
la cai dat chuan dé dam bao trao
déi mau thich hop gitra cac thiét bi
khac nhau (vd: may anh KTS, man
hinh, may in, may quét, v.v...)

3. User Define (Tw chon); ngwoi dung
co thé‘ tw chon cai dat mau sac wu
tién bang cach chinh mau do, luc va
lam.

& Ghi chu

Do mau anh sang tda ra ttr moét vat dung
trong khi né dwoc 1am néng. S6 do nay
dwoc thé hién dwa trén ty 18 tuyét déi, (murc
do Kelvin). Cac muc nhiét dé Kevin thap
hon nhw 2004K [a mau dé; cac mirc nhiét
dd cao hon nhw 9300K [a mau lam. Nhiét
dd trung tinh 1a mau trdng & mirc 6504K.

H9: Toi c6 thé két ndéi man hinh LCD
v&i moi PC, may chu hay may
Mac?

Dap: C6 thé. Tat ca cac man hinh LCD

Philips déu hoan toan twong thich
v@i cac PC, may Mac va may cha
chuan. Ban co6 thé can cé dau ndi
cap dé két ndi man hinh maéi hé
théng may Mac. Vui long lién hé voi
nhan vién kinh doanh cla Philips dé
biét thém thong tin.
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H10: Man hinh LCD Philips c(3 hé tro
chuan Plug-and-Play (Cam vao la

phat)?

: C06, cac man hinh Philips déu hd tro
chuén Plug-and-Play twong thich
v&i Windows 7/Windows 8/Vista/XP/
NT, Mac OSX, Linux

H11: Anh chap ch&n hay anh thir néng
hay anh ao hay anh béng ma trén
man hinh LCD la gi?

Hién thi lién tuc cac anh tinh trong
mot thdi gian dai cé thé gay ra hién
twong “anh thir néng”, con duwoc
goi la “anh ao” hay “anh béng ma”,
trén man hinh cla ban. “Anh thir
néng”, “Anh &o” hay “Anh béng ma”
la hién twong phd bién trong céng
nghé man hinh LCD. Trong moi
trwdng hop, hién twong “anh thir
néng” hay “anh ao” hay “anh béng
ma” sé bién mét dan trong mét thoi
gian sau khi da t&t nguén.

Ludn bat trinh bao vé man hinh
chuyén déng khi ban khéng st
dung man hinh.

Ludn bat vng dung lam m&i man
hinh dinh ky, néu khéng, man hinh
LCD cta ban sé hién thj nhirng noi
dung tinh khéng thay dbi.

) canh bao

Khéng thé bat anh bdo v& man hinh, hodc
ng dung cap nhat man hinh dinh ky co
thé gay ra cac sw cd “thtr néng” hodc “anh
sau” hoac “anh bong ma” nghiém trong
von sé& khéng bién mét va cling khéng

thé khac phuc. Thiét hai vira néu khéng
bao gdm trong chinh sach bao hanh cla
chung toi.

H12: Tai sao man hinh cua téi hién thi
van ban sac nét va cac ky tw rang
cwa?

Man hinh LCD cua ban hoat déng
t6t nhat & d6 phan giai gbc 1920 x
1080 @ 60 Hz. D& man hinh hién
thj tét nhéat, vui long st dung do
phan giai nay.

Dap:
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